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1. INTENDED USE

The BD OneFlow™ ALOT (Acute Leukemia Orientation Tube) is 
intended for flow-cytometric immunophenotyping of aberrant 
immature populations of hematopoietic cells (lymphoid and non-
lymphoid lineage) in bone marrow and peripheral blood as an aid in 
the diagnosis of acute lymphoblastic leukemia and non-lymphoid acute 
leukemia. The BD OneFlow ALOT is designed for use with a suitably 
equipped BD flow cytometer and software designated for in vitro 
diagnostic use.

2. SUMMARY AND EXPLANATION

Acute leukemias are a heterogeneous group of diseases characterized as 
having a clonal (neoplastic) population of immature hematopoietic 
cells in the peripheral blood (PB) or bone marrow (BM).1 There are 
two major classes of acute leukemias: lymphoid precursor leukemias 
and acute myeloid leukemias (AML). The lymphoid precursor 
leukemias are divided into B-cell and T-cell precursor lymphoblastic 
leukemias (BCP-ALL and T-ALL, respectively). In addition, a small 
number of neoplasms do not fit into any of these categories because 
they either show no clear expression of markers indicative of a 
particular lineage, or they express markers specific to more than one 
lineage. They include acute undifferentiated leukemia (AUL) and mixed 
phenotype acute leukemia (MPAL).

The EuroFlow™* Consortium designed multicolor antibody panels to 
fully characterize the cell populations in a patient specimen using 
immunophenotypic markers that are indicative of normal and 
abnormal cells.1 In addition to the optimized multicolor antibody 

* The EuroFlow trademark and logo and the EuroFlow™ antibody panels are property 
of the EuroFlow Consortium and cannot be reproduced or published without prior 
written permission from the EuroFlow coordinator (www.euroflow.org).

http://www.euroflow.org
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panels, the EuroFlow protocol comprises standardized procedures for 
cytometer setup, determination of assay settings, sample preparation, 
staining, and acquisition, and data analysis.2

The single-tube screening panels and multi-tube classification panels fit 
into the EuroFlow diagnostic algorithm for the identification and 
classification of hematological disorders. Each tube contains a set of 
backbone markers and a set of classification markers.1 Backbone 
markers are shared across a particular set of panels and are used to 
normalize the samples so that data files can be combined and analyzed 
as a single large data file. They are markers that identify distinct cell 
populations in a particular cell lineage. Classification markers have 
been selected for their diagnostic utility in discriminating between cell 
types within a given lineage and in classifying the abnormal cell type in 
the sample.

3. PRINCIPLES OF THE PROCEDURE

Multiparameter flow cytometry is a sensitive and rapid tool for the 
qualitative and quantitative characterization of cell populations in a 
specimen. Cells are incubated with fluorochrome-conjugated 
antibodies which bind to their target molecules. The stained cells can 
then be analyzed on a single-cell basis. Multiparameter analysis of the 
data is used to identify the cell populations in the patient specimen and 
can lead to the identification of an aberrant clonal cell population.

The number of parameters used in flow cytometric 
immunophenotyping of hematological disorders has increased in recent 
years. BD OneFlow ALOT contains a panel of fluorochrome-
conjugated antibodies that identify immature populations of 
hematopoietic cells in the B-lymphoid, T-lymphoid, and non-lymphoid 
lineages. Analysis of the dot plots allows for the identification of 
clonally expanded populations of immature hematopoietic precursor 
cells.
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4. REAGENT COMPOSITION

BD OneFlow ALOT consists of two single-use tubes containing 
fluorochrome-conjugated antibodies in an optimized dried 
formulation. The BD OneFlow ALOT (S) tube contains antibodies that 
recognize markers on the surface of cells, and the BD OneFlow 
ALOT (C) tube contains antibodies that recognize antigens in the 
cytoplasm of cells after fixing and permeabilizing them. See Table 1.

The antibodies in the BD OneFlow ALOT tubes were chosen for their 
ability to identify and characterize aberrant immature populations of 
hematopoietic cells.

The tubes utilize different sets of backbone markers, depending on the 
set of classification tubes that will be used. 

Table 1 BD OneFlow ALOT antibody panel

Antibody Tube Fluorochrome Clone Isotype

MPO C FITC MPO-73 IgG1, κ

CD79a C PE HM574 IgG1, κ

CD3 C V450a

a. BD Horizon™ V450, BD Horizon™ V500-C

UCHT-15,6 IgG1, κ

CD34 S PerCP-Cy™5.5b

b. Cy™ is a trademark of GE Healthcare. This product is subject to proprietary rights of GE Healthcare and 
Carnegie Mellon University, and is made and sold under license from GE Healthcare. This product is licensed for 
sale only for in vitro diagnostics. It is not licensed for any other use. If you require any additional license to use 
this product and do not have one, return this material, unopened, to BD Biosciences, 2350 Qume Drive, San 
Jose, CA 95131, and any money paid for the material will be refunded.

8G127 IgG1, κ

CD19 S PE-Cy™7b SJ25-C18,9 IgG1, κ

CD7 S APC M-T70110 IgG1, κ

CD3 S APC-H7 SK711,12 IgG1, κ

CD45 S V500-Ca 2D15,13 IgG1, κ
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For the BCP-ALL panel, the backbone markers in BD OneFlow ALOT 
are CD45, CD34, and CD19. 

For the T-ALL panel, the backbone markers in BD OneFlow ALOT are 
CD45, cytoplasmic CD3 (cyCD3), and CD3. 

For the AML panels, the backbone markers in BD OneFlow ALOT are 
CD45 and CD34.

CD34 and negative or dim expression of CD45 (CD45neg/dim) are 
markers for immature cells.

Cytoplasmic myeloperoxidase (cyMPO) is a myeloid lineage marker.

cyCD3 and CD7 are T-cell lineage markers. CD3 is used as a maturity 
marker for T cells.

CD19 and cytoplasmic CD79a (cyCD79a) are B-cell lineage markers.

Refer to the article describing the EuroFlow antibody panels1 for a full 
description of the utility of the antibodies chosen for the BD OneFlow 
ALOT tube.

The BD OneFlow ALOT (S) tube contains 0.7816% 2-methyl-4-
isothiazolin-3-one (CAS number 2682-20-4) and 0.1369% sodium 
azide (CAS number 26628-22-8). The BD OneFlow ALOT (C) tube 
contains 0.5322% 2-methyl-4-isothiazolin-3-one (CAS number 2682-
20-4) and 0.3446% sodium azide (CAS number 26628-22-8). The 
reagents are classified as hazardous according to the Globally 
Harmonized System of Classification and Labelling of Chemicals 
(GHS).
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5. STORAGE AND HANDLING

Store tubes at 2°C–27°C in the foil pouch. Do not freeze the reagent or 
expose it to direct light at any time during storage or incubation with 
cells. The dried fluorochrome-conjugated antibodies are stable until the 
expiration date shown on the pouch and tube labels when stored as 
directed. Do not use after the expiration date. Once the pouch is 
opened, the dried fluorochrome-conjugated antibodies are stable for 
one month when stored as directed.

CAUTION Ensure that the pouch is completely resealed after removing 
a tube. The reagent is very sensitive to moisture. Do not remove the 
desiccant from the reagent pouch.

Warning

H317 May cause an allergic skin reaction.
H412 Harmful to aquatic life with long lasting effects.

P261 Avoid breathing dust/fume/gas/mist/vapors/spray.
P280 Wear protective gloves/protective clothing/eye protection/face protection.
P273 Avoid release to the environment.
P302+P352 IF ON SKIN: Wash with plenty of water.
P333+P313 If skin irritation or rash occurs: Get medical advice/attention.
P362+P364 Take off contaminated clothing and wash it before reuse.
P501 Dispose of contents/container to an appropriate treatment and disposal 
facility in accordance with applicable laws and regulations, and product 
characteristics at time of disposal.
EUH210 Safety Data Sheet available on request.
Contains 2-methyl-4-isothiazolin-3-one: May produce an allergic reaction.
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6. REAGENTS AND MATERIALS

Reagents Provided

BD OneFlow ALOT is provided as single-use tubes in foil pouches. 
Each kit contains four pouches:

• two pouches, each containing five tubes of BD OneFlow ALOT (S)
• two pouches, each containing five tubes of BD OneFlow ALOT (C)

Reagents or Materials Required but Not Provided

• Templates installer CD for BD OneFlow™ Assays 
(Catalog No. 659305)

The OneFlow ALOT template is provided on an installer CD. The 
template contains two global worksheets: the BD OneFlow ALOT 
Acquisition worksheet and the BD OneFlow ALOT Analysis 
worksheet. Unless you already have the current OneFlow ALOT 
template, you will have to order the installer CD the first time you 
order BD OneFlow ALOT. The installer CD also contains the 
OneFlow Setup template and templates for other BD OneFlow™ 
reagents.

The Instrument Setup Guide for BD OneFlow™ Assays and the 
BD OneFlow™ Application Guide for Acute Leukemias are 
provided on separate CDs along with the installer CD. The 
Application Guides for BD OneFlow™ Assays CD also contains 
application guides for other BD OneFlow reagents.

• Pasteur pipet
• Serological pipet
• Micropipettor with tips
• Vortex mixer
• Wash buffer (filtered phosphate buffered saline (PBS) + 0.5% 

bovine serum albumin (BSA) + 0.09% or 0.1% sodium azide)
• Centrifuge
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• BD FACSDiva™ CS&T IVD beads (Catalog No. 656046 or 
656047)

• BD OneFlow™ Setup Beads (Catalog No. 658620)
• BD™ FC Beads 8-color kit for BD OneFlow™ Assays 

(BD FC Beads) (Catalog No. 658621)
• FIX & PERM®† Cell Fixation & Cell Permeabilization kit

7. INSTRUMENT

BD OneFlow ALOT is for use on a BD FACSCanto™ II flow cytometer 
with a 3-laser, 8-color, 4-2H-2V BD default optical configuration 
(4-2H-2V), running BD FACSDiva™ software v8.0.1 or later.

8. SPECIMENS

BD OneFlow ALOT can be used for immunophenotyping by flow 
cytometry of PB or BM aspirates collected in EDTA or heparin (for 
example, in BD Vacutainer® tubes). Each type of specimen can have 
different storage conditions and limitations that should be considered 
prior to collection and analysis.14,15,16

Specimens should be processed immediately after collection. If a longer 
period of time is desired, each laboratory should validate that 
specimens processed and stored according to their procedures produce 
equivalent results to specimens processed immediately after collection. 
PB17,18,19 or BM19,20 specimens collected in anticoagulants may be 
stored at room temperature for up to 24 hours before testing.

Specimens with large numbers of nonviable cells can give erroneous 
results due to selective loss of populations and to increased nonspecific 
binding of antibodies to nonviable cells. Viability of specimens should 
be assessed and a cutoff value established. A cutoff value of at least 
80% viable cells has been suggested.14

† FIX & PERM® is a registered trademark of Nordic-MUbio BV.
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Specimens should be acquired immediately after staining. If a longer 
period of time is desired, each laboratory should validate that stained 
specimens acquired after being held under their storage conditions 
produce equivalent results to specimens acquired immediately after 
staining. Protect stained specimens from light until they are acquired.

WARNING All biological specimens and materials coming in contact 
with them are considered biohazards. Handle as if capable of 
transmitting infection21,22 and dispose of with proper precautions in 
accordance with federal, state, and local regulations. Never pipette by 
mouth. Wear suitable protective clothing, eyewear, and gloves.

Avoid using potentially compromised specimens, including clotted or 
lipemic specimens.

9. PROCEDURE

Installing the OneFlow ALOT Template

The OneFlow ALOT template has to be installed before you run the 
assay for the first time. Additional templates can be installed at the 
same time, as needed. If you will analyze the FCS files on a different 
workstation from the one used to acquire the samples, ensure that you 
install the templates on both workstations.

NOTE When you select a template to install, it will always overwrite 
any template with the same name that was previously installed on the 
system. If you do not want an existing template on your computer to 
be overwritten, do not select that template from the installer during the 
installation process.

1. Insert the installer CD and click the installer icon.

NOTE If the installer does not start automatically, access it 
through the CD drive and open it.

2. Follow the instructions in the dialog.
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The installer will copy and paste the templates in the folder 
D:\BDExport\Templates\Panel\BD Panels.

NOTE If your system has only one drive, the templates will be 
installed in C:\BDExport\Templates\Panel\BD Panels.

After installation is complete, a dialog opens, summarizing which 
templates have been successfully copied into the folder.

3. Click OK to close the dialog.

4. The installer ReadMe file opens. Click the close box when you 
have finished reading it.

5. Eject the installer CD.

Setting Up the Cytometer

1. Use BD FACSDiva CS&T IVD beads and BD FACSDiva software 
v8.0.1 or later to define the baseline of the cytometer and to run a 
daily performance check of the cytometer. See the BD FACSDiva™ 
CS&T IVD Beads IFU and the Instrument Setup Guide for 
BD OneFlow™ Assays for more information.

2. Use BD OneFlow Setup beads, the OneFlow Setup template, lysed 
washed blood, and BD FACSDiva software v8.0.1 or later to set 
photomultiplier tube (PMT) and scatter voltages monthly. See the 
BD OneFlow™ Setup Beads IFU and the Instrument Setup Guide 
for BD OneFlow™ Assays for more information.

3. Use BD FC Beads and BD FACSDiva software v8.0.1 or later to set 
fluorescence compensation monthly. See the BD™ FC Beads 
8-color kit for BD OneFlow™ Assays IFU and the Instrument 
Setup Guide for BD OneFlow™ Assays for more information.

Staining the Specimen

NOTE Before staining the specimen, confirm that the cytometer has 
been properly set up. We recommend that you confirm that the PMT 
voltages (PMTVs) are still within their daily target ranges. See the 



14

chapter for daily setup in the Instrument Setup Guide for 
BD OneFlow™ Assays for more information.

1. If the pouches are stored refrigerated, allow them to reach room 
temperature before opening them.

NOTE The reagent is very sensitive to moisture. To avoid 
condensation, open the pouches only if they are at room 
temperature.

2. For each patient specimen, remove a BD OneFlow ALOT (S) tube 
from its pouch. Do not remove the BD OneFlow ALOT (C) tube 
from its pouch at this time.

3. Place the tubes in a rack, protected from light.

4. Immediately reseal the pouch with any unused tubes.

NOTE Ensure that the pouch is completely resealed after removing 
a tube. The reagent is very sensitive to moisture. Do not remove 
the desiccant from the reagent pouch.

The reagent is very sensitive to light. Start staining the specimen 
immediately.

5. Write the patient ID on the tube label within the area provided.

NOTE Write the current date on the pouch label when it is first 
opened. Use the tubes from that pouch within one month before 
opening the next pouch.

6. Invert the specimen in the collection tube 10 times to mix well.

7. Add 50 µL of wash buffer and 50 µL of unwashed specimen to the 
BD OneFlow ALOT (S) tube. 
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Staining from 3 × 104 to 2 × 106 white blood cells gives equivalent 
results.

NOTE Make sure that all of the specimen is in contact with the 
reagent at the bottom of the tube.

NOTE Do not wipe the outside of the tube with ethanol or 
isopropanol because the ink on the printed label can run.

8. Vortex vigorously 3–5 seconds to mix well.

9. Incubate for 30 minutes at 20°C–25°C, protected from light.

10. Add 1.5 mL of wash buffer. Vortex vigorously 3–5 seconds to mix 
well.

11. Add an additional 1.5 mL of wash buffer. Vortex gently to mix.

12. Centrifuge at 540g for 5 minutes at 20°C–25°C.

13. Remove the supernatant without disturbing the cell pellet, leaving 
approximately 50 µL of residual liquid in the tube.

14. Vortex vigorously until the cell pellet is completely resuspended.

15. Add 100 µL of FIX & PERM Reagent A (fixation solution) to the 
tube. Vortex vigorously 3–5 seconds to mix well.

16. Incubate for 15 minutes at 20°C–25°C, protected from light.

17. Add 1.5 mL of wash buffer. Vortex vigorously 3–5 seconds to mix 
well.

18. Add an additional 1.5 mL of wash buffer. Vortex gently to mix.

19. Centrifuge at 540g for 5 minutes at 20°C–25°C.

20. Remove the supernatant without disturbing the cell pellet, leaving 
approximately 50 µL of residual liquid in the tube.
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21. Vortex vigorously until the cell pellet is completely resuspended.

NOTE If you are unable to obtain a single-cell suspension, see 
Troubleshooting.

22. Measure the volume in each tube using a pipet and add wash 
buffer to give a final volume of 100 µL in each tube. Vortex 
3–5 seconds to mix well.

NOTE It is important to have a final volume of 100 µL in each 
tube so that all of the cells will be completely permeabilized in 
steps 25–28.

23. Remove the appropriate number of BD OneFlow ALOT (C) tubes 
from the pouch and reseal the pouch immediately.

NOTE Ensure that the pouch is completely resealed after removing 
a tube. The reagent is very sensitive to moisture. Do not remove 
the desiccant from the reagent pouch.

24. Write the patient ID on the BD OneFlow ALOT (C) tube label 
within the area provided.

NOTE Write the current date on the pouch label when it is first 
opened. Use the tubes from that pouch within one month before 
opening the next one.

25. Add 100 µL of FIX & PERM Reagent B (permeabilization 
solution) to the BD OneFlow ALOT (C) tube.

26. Transfer 100 µL of the sample from the BD OneFlow ALOT (S) 
tube to the corresponding BD OneFlow ALOT (C) tube.

NOTE Make sure that the patient ID numbers on the two tubes are 
the same.

27. Vortex the BD OneFlow ALOT (C) tube vigorously 3–5 seconds to 
mix well. 

28. Incubate for 15 minutes at 20°C–25°C, protected from light.
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29. Add 1.5 mL of wash buffer. Vortex vigorously 3–5 seconds to mix 
well.

30. Add an additional 1.5 mL of wash buffer. Vortex gently to mix.

31. Centrifuge at 540g for 5 minutes at 20°C–25°C.

32. Remove the supernatant without disturbing the cell pellet, leaving 
approximately 50 µL of residual liquid in the tube.

33. Add 200 µL of wash buffer to the tube. Vortex vigorously 
3–5 seconds to completely resuspend the cell pellet.

NOTE Specimens should be acquired immediately after staining. If 
a longer period of time is desired, each laboratory should validate 
that stained specimens acquired after being held under their 
storage conditions produce equivalent results to specimens 
acquired immediately after staining. Protect stained specimens 
from light until they are acquired.

Setting Up the Experiment

1. From the menu bar, select Edit > User Preferences, then navigate to 
the FCS tab, and select Export FCS after recording, to 
automatically export the FCS files after acquisition. Click OK.

2. Confirm that the cytometer is in the 4-2H-2V BD default 
configuration.

3. From the menu bar, select Experiment > New Experiment > Blank 
Experiment. Click OK.

NOTE You can also create an experiment directly from the 
Browser using the Experiment icon.

4. If prompted by the CST Mismatch dialog, select Use CST Settings.

5. Rename the experiment according to your laboratory practice.
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6. In the Browser, right-click Cytometer Settings > Link Setup and 
select the appropriate compensation matrix calculated using 
BD FC Beads within the past 31 days. Click Link. 

See the BD™ FC Beads 8-color kit for BD OneFlow™ Assays IFU 
or the Instrument Setup Guide for BD OneFlow™ Assays.

7. If prompted by the Cytometer Settings Mismatch dialog, select 
Overwrite.

8. Right-click Cytometer Settings > Unlink From and select the 
previously linked compensation setup. Click OK.

NOTE Unlinking the compensation setup allows updated 
application settings to be applied while retaining compensation 
values.

9. In the Browser, right-click Cytometer Settings > Application 
Settings > Apply and select the most recent application settings 
determined within the last 31 days using the BD OneFlow Setup 
beads. Click Apply.

10. A Confirm dialog opens. Select Keep the compensation value.

11. If prompted by the Confirm Cytometer Changes dialog, click Yes 
to overwrite the cytometer values for FSC Area Scaling.

12. From the menu bar, select Experiment > New Specimen.

The Panel Templates dialog opens.

13. Navigate to the BD Panels tab and select the OneFlow ALOT 
template.

14. Indicate the number of patient specimens you want to acquire 
using the Copies field near the bottom of the BD Panels tab. Click 
OK.
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15. Rename each specimen, for example, with the appropriate patient 
ID in front of the specimen name.

NOTE If you have to re-run a particular patient sample, set the 
current tube pointer to the tube you wish to re-run. Click Next 
Tube in the Acquisition Dashboard to create another tube for that 
patient. Do not select Experiment > New Tube from the menu bar 
or use the New Tube icon from the Browser menu bar to create the 
additional tube to be acquired because the labels and barcode 
fields will not be populated.

NOTE If you want to acquire additional patient samples in the 
experiment, repeat steps 12–15 to add new specimens. Two 
Confirm dialogs will open asking if you want to create another 
ALOT acquisition worksheet or another ALOT analysis 
worksheet. Click Cancel in each dialog.

16. From the menu bar, select Experiment > Experiment Layout and 
navigate to the Keywords tab.

17. Highlight the Product ID keyword for the appropriate tube, and 
scan the barcode on the BD OneFlow ALOT (C) tube label.

NOTE If you cannot scan the barcode on the tube label, see 
Troubleshooting.

18. Manually add the appropriate information to the remaining 
keywords, as needed.

19. Click OK to close the Experiment Layout.

Acquiring the Stained Sample

1. In the Browser, expand the appropriate specimen and set the 
current tube pointer to that tube.

2. Select the BD OneFlow ALOT Acquisition worksheet tab.

3. Vortex the stained tube 3–5 seconds at low speed.
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4. Install the tube on the cytometer. Adjust the flow rate to Medium 
in the Acquisition Dashboard. Click Acquire Data.

5. Verify that the population is on scale and adjust the gate in the first 
plot of the ALOT acquisition worksheet to exclude debris, if 
needed.

6. Click Record Data in the Acquisition Dashboard to collect total 
events.

NOTE The template automatically collects 100,000 total events. 
Use the menu in the Acquisition Dashboard to select a different 
number of events to acquire, if needed. Collecting total events from 
3 × 104 to 2 × 106 stained cells gives equivalent results.

7. Inspect the dot plots on the ALOT acquisition worksheet, and 
adjust the gates as needed.

Some of the dot plots might look different from those in other 
experiments. The initial FSC-A vs SSC-A dot plot to identify cells 
and eliminate debris may appear compressed. This is a 
consequence of the target values used to create the application 
settings. The values are specified by the EuroFlow Consortium.

NOTE Enlarge the dot plots while adjusting the gates so you can 
more readily see the populations of interest.

The FSC-A vs SSC-A dot plot is used to identify cells.

The CD45 V500-A vs SSC-A dot plot from the Cells population is 
used to identify leukocytes.

The CD45 V500-A vs SSC-A dot plot from the Leukocytes 
population is used to identify the CD45neg/dim population.

The remaining dot plots do not contain gates and are included to 
assess staining of the CD45neg/dim population with all of the 
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antibodies, therefore serving as an internal quality control for the 
tube.

NOTE See the BD OneFlow™ Application Guide for Acute 
Leukemias for examples of the dot plots showing populations of 
normal cells in the ALOT acquisition worksheet.

8. Continue until all of the tubes have been acquired.

9. From the menu bar, select File > Export > Experiments, and select 
the Directory Export option. Click OK.

Analyzing the Data Using BD FACSDiva Software

1. From the menu bar, select File > Import > Experiments.

2. Select the experiment that you want to analyze. Click Import.

The experiment with the associated acquisition and analysis 
worksheets opens.

3. Select the BD OneFlow ALOT Analysis worksheet tab.

4. Inspect the dot plots on page 1 of the ALOT analysis worksheet, 
and adjust the gates as needed.

Some of the dot plots might look different from those in other 
experiments. The initial FSC-A vs SSC-A dot plot to identify cells 
and eliminate debris may appear compressed. This is a 
consequence of the target values used to create the application 
settings. The values are specified by the EuroFlow Consortium.

NOTE Enlarge the dot plots while adjusting the gates so you can 
more readily see the populations of interest.

The first three dot plots on page 1 of the ALOT analysis worksheet 
identify cells, FSC singlets, and SSC singlets. Debris and doublets 
are excluded by adjusting the gates.

Examine the Leukocytes population in the CD45 V500-A vs SSC-A 
dot plot from the SSC Singlets gate.
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Examine the CD45neg/dim population in the CD45 V500-A vs SSC-
A dot plot from the Leukocytes gate.

The CD34 PerCP-Cy5.5-A vs SSC-A dot plot does not have a gate 
and is used for informational purposes.

NOTE See the BD OneFlow™ Application Guide for Acute 
Leukemias for examples of dot plots showing populations of 
normal cells in the ALOT analysis worksheet.

5. Inspect the dot plots identifying T cells on the top half of page 2 of 
the ALOT analysis worksheet, and adjust the gates as needed.

Cells expressing cytoplasmic CD3 (cyCD3+) are identified in the 
cyCD3 V450-A vs SSC-A dot plot from the Leukocytes population.

T cells are identified in the CD3 APC-H7-A vs cyCD3 V450-A dot 
plot from the cyCD3+ population. The cyCD3+ cells are 
characterized in the remaining dot plots.

6. Inspect the dot plots identifying B cells on the bottom half of 
page 2 of the ALOT analysis worksheet, and adjust the gates as 
needed.

CD19+ cells are identified in the CD19 PE-Cy7-A vs SSC-A dot 
plot from the Leukocytes population.

B cells are identified in the cyCD79a PE-A vs CD19 PE-Cy7-A dot 
plot from the CD19+ population. The CD19+ cells are 
characterized in the remaining dot plots.

7. Inspect the dot plots identifying non-lymphoid cells on page 3 of 
the ALOT analysis worksheet, and adjust the gates as needed.

Non-lymphoid cells are identified in the CD45 V500-A vs SSC-A 
dot plot from the NOT(cyCD3+ OR CD19+) population.

Cells expressing cytoplasmic myeloperoxidase (cyMPO+) are 
identified in the cyMPO FITC-A vs SSC-A dot plot from the Non-
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Lymphoid population. The non-lymphoid cells are characterized in 
the remaining dot plots.

8. Inspect the dot plots identifying CD45neg/dim cells on page 4 of the 
ALOT analysis worksheet, and adjust the gates as needed.

CD45neg/dim cells are identified in the CD45 V500-A vs SSC-A dot 
plot from the Leukocytes population.

CD45neg/dimCD34+ cells are identified in the CD34 PerCP-Cy5.5-
A vs SSC-A dot plot from the CD45neg/dim population.

The remaining dot plots present the expression of each of the 
markers in combination with CD34 for the CD45neg/dim 
population.

9. Examine the results in the statistics box on page 5 of the ALOT 
analysis worksheet.

Confirm that all of the keywords are present in the statistics box. If 
any of the keywords are missing, see Troubleshooting.

10. Perform further analyses as needed.

NOTE The gates in the dot plots of the ALOT analysis worksheet 
are provided for analyzing normal and aberrant cell populations in 
the specimen. Aberrant cell populations will require further 
analysis.

11. Save the ALOT analysis worksheet as a PDF.

NOTE The ALOT analysis worksheet is a global worksheet. Any 
gates that are adjusted when analyzing a sample on a global 
worksheet will be changed in previously analyzed files. Previously 
saved PDFs will not change, but if you go back to a previously 
analyzed global worksheet, you will have to readjust the gates so 
they match what they were before.

12. (Optional) Click Print to print the ALOT analysis worksheet.
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13. Analyze the next sample.

10. PERFORMANCE CHARACTERISTICS

Precision

Precision studies for the reproducibility and repeatability of 
BD OneFlow ALOT were performed at BD Biosciences laboratories in 
San Jose, CA, USA.

Two operators each performed two separate runs per day on either of 
two BD FACSCanto II flow cytometers. The operators switched to the 
other instrument each day over a period of eight days. For each run, 
duplicate samples of CD-Chex CD34®‡ were stained using three lots 
of BD OneFlow ALOT by each operator, and then acquired and 
analyzed using the OneFlow ALOT template in BD FACSDiva 
software. 

Reproducibility

Three cell populations were identified as being a percentage of the cell 
populations indicated in Table  2. The reproducibility of the subset 
percentages was calculated for each cell population. Reproducibility 
comprises four components: operator/instrument-to-operator/
instrument, lot-to-lot, run-to-run, and day-to-day reproducibility.

‡ CD-Chex CD34 is a registered trademark of Streck, Inc.

Table 2 Reproducibility of subset percentages

Population Mean SDa
Upper 95% 
CLb of SD %CVc

Upper 95% 
CL of %CV

T cells (% leukocytes) 29.0 0.2 0.6 0.7 1.9

B cells (% leukocytes) 5.7 0.1 0.6 2.3 10.0

cyMPO+ cells 
(% leukocytes)

54.8 1.1 4.8 2.0 8.8
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Repeatability

Three cell populations were identified as being a percentage of the cell 
populations indicated in Table 3. The within-run precision (tube-to-
tube repeatability) of the subset percentages was calculated for each 
cell population.

Method Comparison

A side-by-side comparison study between the BD OneFlow system on 
the BD FACSCanto II flow cytometer and the EuroFlow system on the 
BD FACSCanto II flow cytometer was performed at 5 external clinical 
sites. The BD OneFlow system comprises BD OneFlow Setup Beads, 
BD FC Beads for compensation, and the BD OneFlow ALOT reagent. 
The EuroFlow reference system comprises Sphero™** Rainbow 
calibration particles (8 peaks), single color stained cells for 
compensation, and the corresponding EuroFlow reagent cocktails. 
Both methods used BD FACSDiva CS&T IVD beads to perform 
instrument quality control. Aberrant immature hematopoietic cell 
populations from 93 patients were identified using the two systems, 

a. SD = Standard deviation
b. CL = Confidence limit
c. %CV = % Coefficient of variation

Table 3 Repeatability of subset percentages

Population Mean SD
Upper 95% 

CL of SD %CV
Upper 95% 
CL of %CV

T cells (% leukocytes) 29.0 0.5 0.5 1.7 1.9

B cells (% leukocytes) 5.7 0.1 0.2 2.5 2.8

cyMPO+ cells 
(% leukocytes)

54.8 0.8 0.9 1.4 1.6

**Sphero is a trademark of Spherotech, Inc.
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and compared. A total of 37 PB specimens and 56 BM specimens were 
enrolled in the study. PB and BM specimens were stained within 
24 hours of collection. The stained samples were acquired within 
45 minutes of staining. Samples with populations of immature 
hematopoietic cells were identified as being non-lymphoid or 
lymphoid. Samples identified as being non-lymphoid included 
specimens with AUL. Samples identified as being lymphoid included 
37 B-lymphoid lineage and 7 T-lymphoid lineage specimens.

Agreement was calculated as follows:
Overall % agreement = ((a+d)/(a+b+c+d))×100

wherein,
a = number of samples identified as non-lymphoid for both systems,
b = number of samples identified as non-lymphoid for the BD OneFlow system but identified as 
lymphoid for the EuroFlow system,
c = number of samples identified as lymphoid for the BD OneFlow system but identified as non-
lymphoid for the Euroflow system, and
d = number of samples identified as lymphoid for both systems.

The results for samples identified as non-lymphoid or lymphoid were 
tabulated. See Table 4.

Overall % agreement is 100%. The lower 95% confidence limit is 
96.8%.

Table 4 Agreement for aberrant immature hematopoietic cells being lymphoid or 
non-lymphoid

Comparator method 
(EuroFlow system)

Non-lymphoid Lymphoid Total

Investigational method 
(BD OneFlow system)

Non-lymphoid 49 0 49

Lymphoid 0 44 44

Total 49 44 93
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Equivalency

A qualitative assessment of the cell populations for the presence or 
absence of critical BD OneFlow ALOT markers was performed for 
each specimen. Specimens were analyzed using the BD OneFlow system 
and the corresponding EuroFlow system described previously. Overall 
agreement of the two systems in assessing the expression, either 
positive or negative, of the indicated markers in the specimens was 
calculated. See Table 5.

The results of the method comparison and equivalency studies indicate 
that the two systems are substantially equivalent.

11. LIMITATIONS

• Use of therapeutic monoclonal antibodies in patient treatment can 
interfere with recognition of target antigens by this reagent. This 
should be considered when analyzing samples from patients 
treated in this fashion. BD Biosciences has not characterized the 
effect of the presence of therapeutic antibodies on the performance 
of this reagent.

Table 5 Equivalency of the BD OneFlow system to the EuroFlow system

Marker
% Overall agreement for 
the expression of marker

Lower 95% CL of % 
overall agreement

CD45neg/dim 100% 96.8%

CD45neg/dim and cyCD3 100% 96.8%

CD45neg/dim and CD3 100% 96.8%

CD45neg/dim and CD19 100% 96.8%

CD45neg/dim and cyCD79a 100% 96.8%

CD45neg/dim and cyMPO 100% 96.8%
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• Use of this reagent for diagnostic evaluation of hematologic 
disorders should be performed in the context of a thorough 
immunophenotypic analysis including other relevant markers, for 
example, markers present in the EuroFlow classification panels, 
and other diagnostic tests.

• Use of BD OneFlow ALOT requires experience with leukemia and 
lymphoma immunophenotyping and classification.

• BD OneFlow ALOT has not been tested on specimens from 
patients with minimal residual disease (MRD).

• Avoid using potentially compromised specimens, including clotted 
or lipemic specimens.

WARRANTY

Unless otherwise indicated in any applicable BD general conditions of sale for 
non-US customers, the following warranty applies to the purchase of these 
products.

THE PRODUCTS SOLD HEREUNDER ARE WARRANTED ONLY TO CONFORM TO THE 
QUANTITY AND CONTENTS STATED ON THE LABEL OR IN THE PRODUCT LABELING 
AT THE TIME OF DELIVERY TO THE CUSTOMER. BD DISCLAIMS HEREBY ALL OTHER 
WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR ANY PARTICULAR PURPOSE AND 
NONINFRINGEMENT. BD’S SOLE LIABILITY IS LIMITED TO EITHER REPLACEMENT OF 
THE PRODUCTS OR REFUND OF THE PURCHASE PRICE. BD IS NOT LIABLE FOR 
PROPERTY DAMAGE OR ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES, 
INCLUDING PERSONAL INJURY, OR ECONOMIC LOSS, CAUSED BY THE PRODUCT. 
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TROUBLESHOOTING

Problem Possible Cause Solution

The resolution between 
debris and cells is poor.

Specimen was poorly lysed. Repeat staining; vortex tubes until 
no cell aggregates remain before 
adding FIX & PERM Reagent A.

Specimen is of poor quality. Check cell viability.

Specimen is too old. Obtain a new specimen and stain it 
immediately.

Instrument settings are 
inappropriate.

Follow proper instrument setup 
procedures. See the Instrument Setup 
Guide for BD OneFlow™ Assays.

The cytoplasmic 
staining (cyMPO, 
cyCD79a, cyCD3) is 
dim.

The cells were not 
completely permeabilized.

Repeat staining; carefully measure 
the specimen volumes in the cell 
fixation and permeabilization steps 
such that the ratio of fixed sample to 
FIX & PERM Reagent B is 1:1.

Cells clump after being 
fixed.

Cells were not completely 
resuspended before fixing 
them.

Vortex tubes until no cell aggregates 
remain before adding FIX & PERM 
Reagent A.

Cells were not thoroughly 
washed after fixing them.

1. Fix the cells using FIX & PERM 
Reagent A.

2. Add wash buffer and incubate 
the tubes for 2 minutes, protected 
from light.

3. Centrifuge the tubes and proceed 
to the permeabilization step.

Staining is dim or 
fading.

Cell concentration was too 
high at the staining step.

Check the cell concentration and 
adjust as needed.

The BD OneFlow tube was 
exposed to light for too long.

Repeat staining with a new 
BD OneFlow tube.

Stained cells were stored too 
long before acquiring them.

Repeat staining with a fresh 
specimen and acquire it promptly.
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Few or no cells are 
recorded.

Cell concentration was too 
low.

Resuspend fresh specimen at a 
higher concentration. Repeat 
staining and acquisition.

Cytometer is malfunctioning. Troubleshoot the instrument. See the 
cytometer instructions for use for 
more information.

Some of the dot plots 
are dimmed.

FSC-H and SSC-H were not 
selected when the 
application settings were 
created.

Check that FSC-H and SSC-H are 
selected on the Parameters tab of the 
Inspector.

The barcode on the 
BD OneFlow 
ALOT (C) tube label 
cannot be scanned.

The barcode on the tube 
label has been compromised.

Scan the barcode on the 
BD OneFlow ALOT (C) pouch label 
into the Product ID keyword field in 
the Experiment Layout. Next, after 
the last digit of the barcode, 
manually enter a semicolon (;) 
followed by the six-digit 
tube-specific ID, found adjacent to 
the barcode on the tube label.

The dot plots on the 
worksheets are missing 
or the dot plots do not 
have gates.

The template did not import 
correctly.

1. Close the current experiment.

2. Create a new experiment.

3. Re-import the OneFlow ALOT 
template.

Some of the keywords 
are missing from the 
statistics box in the 
analysis worksheet.

BD FACSDiva software did 
not import all of the 
keywords into the panel 
template.

1. In the Browser, set the current 
tube pointer to the tube that you 
are analyzing.

2. Navigate to the analysis 
worksheet.

3. Right-click the statistics box and 
select Edit Stats View.

4. In the Header tab, select the All 
checkbox.

5. Click OK.

Problem Possible Cause Solution
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